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SAFETY PRECAUTIONS 
(Read these precautions before using this product.) 

 
Before using this product, please read this manual and the relevant manuals 
carefully and pay full attention to safety to handle the product correctly. 

In this manual, the safety precautions are classified into two levels: 

" WARNING" and " CAUTION". 

WARNING Indicates that incorrect handling may cause hazardous conditions, 
resulting in death or severe injury. 

CAUTION Indicates that incorrect handling may cause hazardous conditions, 
resulting in minor or moderate injury or property damage. 

Under some circumstances, failure to observe the precautions given under 

" CAUTION" may lead to serious consequences. 

Make sure that the end users read this manual and then keep the manual 
in a safe place for future reference. 
 

[Design Instructions] 

WARNING 
 When data change, program change, or status control is performed 

from a personal computer to a running programmable controller, 
create an interlock circuit outside the programmable controller to 
ensure that the whole system always operates safely. 
Furthermore, for the online operations performed from a personal 
computer to a programmable controller CPU, the corrective actions 
against a communication error due to such as a cable connection 
fault should be predetermined as a system. 

 

CAUTION 
 The online operations performed from a personal computer to a 

running programmable controller CPU (forced output and 
operating status changes) must be executed after the manual 
has been carefully read and the safety has been ensured. 
The operation failure may cause the injury or machine damage. 
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CONDITIONS OF USE FOR THE PRODUCT 
 
(1) Mitsubishi programmable controller ("the PRODUCT") shall be used in 

conditions; 
i) where any problem, fault or failure occurring in the PRODUCT, if any, 

shall not lead to any major or serious accident; and 
ii) where the backup and fail-safe function are systematically or 

automatically provided outside of the PRODUCT for the case of any 
problem, fault or failure occurring in the PRODUCT. 

(2) The PRODUCT has been designed and manufactured for the purpose of 
being used in general industries. 
MITSUBISHI SHALL HAVE NO RESPONSIBILITY OR LIABILITY 
(INCLUDING, BUT NOT LIMITED TO ANY AND ALL RESPONSIBILITY 
OR LIABILITY BASED ON CONTRACT, WARRANTY, TORT, PRODUCT 
LIABILITY) FOR ANY INJURY OR DEATH TO PERSONS OR LOSS OR 
DAMAGE TO PROPERTY CAUSED BY the PRODUCT THAT ARE 
OPERATED OR USED IN APPLICATION NOT INTENDED OR 
EXCLUDED BY INSTRUCTIONS, PRECAUTIONS, OR WARNING 
CONTAINED IN MITSUBISHI'S USER, INSTRUCTION AND/OR SAFETY 
MANUALS, TECHNICAL BULLETINS AND GUIDELINES FOR the 
PRODUCT.  
("Prohibited Application") 
Prohibited Applications include, but not limited to, the use of the PRODUCT 
in; 
 Nuclear Power Plants and any other power plants operated by Power 

companies, and/or any other cases in which the public could be affected 
if any problem or fault occurs in the PRODUCT. 

 Railway companies or Public service purposes, and/or any other cases 
in which establishment of a special quality assurance system is required 
by the Purchaser or End User. 

 Aircraft or Aerospace, Medical applications, Train equipment, transport 
equipment such as Elevator and Escalator, Incineration and Fuel 
devices, Vehicles, Manned transportation, Equipment for Recreation and 
Amusement, and Safety devices, handling of Nuclear or Hazardous 
Materials or Chemicals, Mining and Drilling, and/or other applications 
where there is a significant risk of injury to the public or property. 

 
Notwithstanding the above, restrictions Mitsubishi may in its sole discretion, 
authorize use  
of the PRODUCT in one or more of the Prohibited Applications, provided that 
the usage of the PRODUCT is limited only for the specific applications agreed 
to by Mitsubishi and provided further that no special quality assurance or 
fail-safe, redundant or other safety features which exceed the general 
specifications of the PRODUCTs are required. For details, please contact the 
Mitsubishi representative in your region. 
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1 AX Application Overview 

1.1 Introduction 
Welcome to AX Application®, a new generation of 
Manufacturing Intelligence software designed to help you 
increase profitability, reduce energy and maintenance costs, 
control operating costs and react to emergent situations 
before they negatively impact your bottom line. 
 
AX Application empowers decision makers at all levels of the 
enterprise with real-time information to help them drive 
global operational efficiency and strengthen competitive 
market advantage.  
AX Application solutions leverage the latest Microsoft 
technologies including the Windows Server, SQL Server, 
SharePoint and Silverlight for rich, IT-friendly visualization 
components. 
 
AX Application is comprised of the following products: 

 AX Application Suite* 
 AX Energy 
 AX Facility 
 AX Quality 
 AX Portal™ 

 

* The AX Application Suite installation is comprised of the 
following options: 

o Platform Services – Core connectivity and 
communications layer shared between 
products 

o AX Portal – Real-time Collaboration and 
Visualization Dashboards 

 AX Portal-SL – Thin-client operations 
and runtime management dashboard, 
which is installed and included as part of 
the Platform Services above 
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 AX Portal-SP – SharePoint-based 
option for runtime visualization. Installs 
the base set of AX Portal-SP Web Parts 
including GraphWorX, TrendWorX, 
AlarmWorX, GridWorX, AssetWorX 
Navigator, AX Energy and AX Facility 
Viewers. 

 ReportWorX Web Parts – Installs the 
optional ReportWorX Web Parts [Report 
Executor and Report Browser] (requires 
ReportWorX Server to be installed). 

o AX Energy – Advanced Energy Management 
Solution (Requires SQL Server 2008 R2 or higher) 

o AX Facility – Predictive Software for Facilities 
Management 

o AX Quality – Complete SPC Quality Software 
Solution 

o Help – Product Documentation 

AX Application Installation also includes the Workbench, a 
multi-functional, centralized Web-based configuration 
environment. 

This Getting Started manual explains how you can: 

 Install the AX Application software. 

 Familiarize yourself with and start using 
Workbench. 

 Access online help and technical support. 

Note: This manual is an abbreviated version of the full AX 
Application Help documentation, which is available in the AX 
Application product installation.
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2 System Requirements 
AX Application has the following minimum system 
requirements. Your system must meet the minimum 
requirement before you can install AX Application. 

 
CPU: 

Dual Core 64-bit processors  
(e.g. AMD Athlon 64 X2, Intel Xeon, or AMD Phenom) 

Memory: 
Minimum: 4 GB of RAM  
Recommended: 6 GB of RAM 

Note: It is recommended that the system page file size 
be a minimum of four (4) times the size of installed 
(physical) RAM. 

Hard Disk: 
Recommended: At least 50 GB free hard disk space is 
recommended – for installation and to allow for SQL 
Server database growth*. 

Drive: 
DVD Drive for installation  

Operating System: 
The following Windows 64-bit operating systems are 
supported, including: 

 Windows Server 2012 R12 x64 
 Windows Server 2012 x64 
 Windows Server 2008 R2 x64 
 Windows Server 2008 x64 

.NET Framework: 

Microsoft .NET Framework 4.5 

Web Server: 

Microsoft Internet Information Services (IIS) 7.0 or 
higher. 

Additional Software: 

Microsoft SQL Server 2014 

Microsoft SQL Server 2012 
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Microsoft SQL Server 2008 R2 SP1 or higher (Note: 
Express Edition is NOT supported for AX Energy) 

Microsoft SharePoint Server 2010 or SharePoint 
Foundation 2010 or higher (required for AX Portal-SP 
only, can be installed on a separate server if desired) 

Web Access: Via Silverlight Publishing: Internet 
Explorer 7 or later, Firefox 3 or later, Safari, Chrome, 
Edge 

Note: It is recommended that the system's page file 
size be a minimum of four (4) times the size of installed 
(physical) RAM. 

Note: The connection to a SQL Server data source 
may be either local or remote. 

Note: Mitsubishi Electric supports SQL databases with 
encryption. 

 

StreamInsight:  

Note: Microsoft StreamInsight, a required component 
for AX Energy will run in demo mode for 180 days if not 
registered with a valid SQL Server license key. This 
means that SQL Express installations will only be able 
to run AX Energy for 180 days unless they are 
upgraded with a valid SQL Server license key. 

Users are encouraged to install StreamInsight with a 
valid license before installing AX Application. If you 
have already installed AX Application and have not yet 
validated your StreamInsight license, please refer to the 
Help documentation for additional instructions. 

 

Optional Hardware: 

Ethernet adapter (for remote PC connections or 
Ethernet I/O) 

USB port (for hardware license or license transfer) 

Serial COM ports or other adapters (for data I/O) 
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Note: The requirements described above are based on 
typical applications. Depending on your specific application, 
the minimum requirements may vary. The system 
requirements above assume that the OPC server(s) are 
installed locally on the system and that the following 
components are all installed and running: AX Energy, AX 
Facility, AX Quality and AX Portal-SP. For AX Application 
application servers that will also utilize portions of the MC 
Works64 HMI/SCADA suite, including tools within the 
Platform Services, note that those requirements are 
separate and must also be taken into consideration. 
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3 Installing AX Application 
The following steps detail the AX Application system 
installation. 

The AX Application installation uses a standard InstallShield 
installer to provide you with options for installing components, 
adding new or existing users, configuring the database 
engine that you use and the size of the tables that are 
created, and more. 

Warning: Prior to installation, verify that the system meets 
minimum hardware and software requirements, as described 
in the System Requirements section. Installation will abort if 
the minimum requirements are not met. 

Note: You cannot install any 10.9x product from Remote 
Desktop when using a shared drive. In such instances, it is 
suggested that you copy the installation's sources to a local 
drive or share the drive via Windows networking rather than 
via Remote Desktop. 
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3.1 Starting the Install 

To Install AX Application: 

1. Insert the installation DVD into your optical drive and 
the installer will begin automatically if autostart is 
operating correctly. If not, open the DVD drive window 
and double-click the Default.hta file icon. The main 
installation screen will appear, as shown below. Select 
“AX Application” under “Product Installation”. 

 

2. You may be asked to install some prerequisite 
components at this time, as in the example shown 
below. Click on the “Install” button to proceed. 
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3. In the Welcome dialog box shown below, click the Next 
button to view the License Agreement step. 

 

4. Click the “I accept the terms of the license 
agreement” radio button and then click the Next button 
to continue. 
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5. In the Login Information window, enter your User 
Name and Password. You can also click on the 'New 
User Information' button to specify info about a new 
user that will be created during installation. Click the 
Next button to continue. 

 

6. In the Setup Type screen that appears, select the type 
of setup you wish to perform, either Complete or 
Custom. Complete installation installs most of the 
components of MC Works64 and will, as an option, 
overwrite the supporting SQL database files or include 
sample displays via MCDemo. 

7. The Database Server window will now appear. Use the 
pull-down menu or click the Browse button to navigate 
to your selected database server. Once selected, you 
can customize your database creation and choose to 
utilize either Windows authentication or SQL Server 
authentication (using the Login ID and password token). 
Click the Next button to continue. 
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8. The following window allows you to decide whether to 
include the additional AX Facility Equipment Library 
[with preconfigured rules for popular Building 
Automation Equipment] in your installation. Customers 
who have purchased AX Facility can contact Mitsubishi 
for the Serial Number to enter here to activate this 
feature. Once the code has been entered (or, for those 
who have not purchased AX Facility, to proceed with 
the normal installation), click the Next button. 

 

9. The next window provides you with the option to go 
“Back” and change any previous installation settings. If 
you are okay with your settings thus far, click on the 
Install button to move to the next steps in the installation.  
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10. The System Setup Dialog will now appear. You can 
either leave the Include all samples checkbox enabled 
(in order to install sample data that you can experiment 
with) or disable this checkbox to install blank tables. 
Advanced configuration will allow settings for additional 
sizing options on the database and log files. You can 
enable Unified database (one database that contains all 
the configurations) and also you can enable Overwrite 
all (overwrite all existing databases), or you can use 
Upgrade automatically all database configurations 
(existing databases will be automatically upgraded to 
the newest version). 
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11. Click the Install button to continue the installation. 

12. Once complete, you will see the following window. Click 
Yes, I want to restart my computer now to restart 
your computer. 
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3.2 Installing Individual Components 

1. Insert the installation DVD into your optical drive and 
the installer will begin automatically if autostart is 
operating correctly. If not, open the DVD drive window 
and double-click the Default.hta file icon. The main 
installation screen will appear, as shown below. You 
can now select your desired individual component for 
installation and the procedure will be similar to section 
3.1 “Starting the Install”. 

 

3.3 Uninstalling AX Application 

The AX Application software can be uninstalled (removed) 
from the system. It is recommended that you back up all of 
your project-related files before uninstalling. If your operating 
system requires a login, you must log in with administrator 
privileges to uninstall. Uninstalling AX Application software 
(or its components) will not uninstall the Licensing software. 
Your valid license will remain activated on your PC. 

To uninstall AX Application: From the Windows Start menu, 
select Settings > Control Panel. Double-click Add/Remove 
Programs. From the list of programs that you can remove, 
select AX Application. Click Change/Remove to remove 
AX Application and all of its components. Select Remove, 
and then click the Next button. When the files are removed, 
the uninstall program will indicate that the process is 
complete.  
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4 Software Licensing 

4.1 Software and Hardware Keys 

AX Application licensing is handled by a software key license 
registration system that does not require a hardware 
protection key. However, Mitsubishi Electric co. does offer 
an optional hardware key which you can purchase.  

4.1.1 Software Licensing 

The software key is a licensing key that resides on the hard 
drive of a computer. Each software key is used on a single, 
specific computer and is used only once. It is activated using 
a Site Key (license file) that is tied to the computer that is 
being licensed.  

An activated license is required to use the software in full 
production mode. This license designates which products 
may be used, as well as the I/O point-count limit that controls 
the number of active data points (tags) that can be used by a 
system. 

For important details about registering and activating 
software licenses for your AX Application installations, refer 
to the MC Works64 .NET Licensing Readme.htm file, 
which is available on your AX Application installation DVD. 
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4.1.2 Hardware Key 

The optional hardware key is a USB thumb drive (or flash 
drive) that you can move from system to system. AX 
Application recognizes the hardware key on the system you 
have the key attached to. A hardware key is easier and is a 
more reliable way of moving a license from one machine to 
another than a software key.  

Upon insertion of the USB key into 
an available USB port, the 
necessary drivers are automatically 
loaded. A green status light will 
illuminate upon successful 
connection. Should the USB key be 
missing or unplugged during 
operation of  
AX Application software, plug the USB key back in either 
within an hour of removal or upon system reboot; otherwise 
the hardware-based license will not be immediately 
recognized. 

4.2 Licensing Utility 

The Software Licensing Utility provides full authorization for 
use to any purchased AX Application product and its 
available options.  
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4.2.1 Running the Licensing Utility 

To launch the License Utility from the Windows Start menu, 
select Programs > MELSOFT > MC Works64 > .NET 
Licensing > License Utility 
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4.2.2 License File 

 
Once you have opened the Software Licensing Utility, you 
can browse for the Site Key (License File) itself. Either click 
on the Browse… button in the License File section of the 
window OR click on File in the top menu, then Select 
License File… . 
 

 
 

This brings up the Windows Explorer so that you may 
browse for the License File itself. Once you have located the 
file, double-click it or click Open to proceed. 
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4.2.3 Activating the 30-day Trial/Emergency License 

Within the Licensing Utility (Software License Activation 
for .NET) dialog box, you can click on the Activate 
Trial/Emerg. License box to initiate a 30-day 
trial/emergency license.  

Note: This license can be activated only once per 
machine. 

 

You will then see a warning about proceeding with activating 
the 30-day trial/emergency license. Click Yes, should you 
wish to proceed. 
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You will then see an additional warning confirming that you 
understand that enabling the trial license will invalidate any 
other software license that is currently active on the machine. 
Click Yes should you wish to proceed. 

 

Once the 30-day trial/emergency license has been enabled, 
you will see the following messages: 
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The PC will then be authorized to run for a one-time only, 
30-day backup period. The PC can be fully authorized at any 
time during or at the conclusion of this temporary backup 
period. Clicking No in the initial windows returns you to the 
Licensing Utility (Software License Activation for .NET) 
dialog box and preserves the existing license. 

Note: Temporary backup license authorization is intended 
for urgent backup situations only. Clicking OK invalidates the 
existing license and activates a temporary backup 
authorization, permanently overwriting any existing license. 
Thus, please use caution when activating a temporary 
backup license authorization. 

4.2.4 Killing a Software Key License 

Killing a software key license deletes it and removes the 
current software license from the machine. 

To Kill or Delete the Existing Software License:  

1. Select Kill Current License within the Licensing Utility 
(Software License Activation for .NET) dialog box. 
Using this option, you can remove the current software 
license from the current machine. 

 



Software Licensing  

 MITSUBISHI ELECTRIC 4-8 

 

A warning message appears on the screen as shown in the 
figure below.  

 

 

IMPORTANT: If you kill your license, you need to get a new 
license from Mitsubishi Electric to restart your AX Application 
product. 

2. Click Yes to continue, or click No to exit. Clicking Yes 
displays one of the following warning messages.  

If you are killing a trial or emergency license, once you 
click Yes you are done.  

Note:  A trial or emergency license cannot be credited 
back to the Web-based License Generator using the Kill 
Code.   
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If you are killing a permanent, registered license, after 
you click Yes, the following warning message appears. 
Notice that the message lists the old Site Key, and a Kill 
Code. It also lists a .TXT file that has been written to 
the PC's desktop; the file name begins with "KillCode". 
This file contains the old Site Key and Kill Code that are 
listed in the message.  

 

3. Click Copy to copy the Kill Code to the Windows 
Clipboard so that you can paste it elsewhere, such as 
on the Mitsubishi Web Licensing Utility.  

4. Look on the desktop for the KillCode*.TXT file. Keep 
this file, and copy it to a safe location! You will have 
to use the information it contains to confirm that you 
have killed your license (via the Mitsubishi Web 
Licensing Utility). 
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5. Proceed with the online steps described in 4.4.3.1 
“Killing a License via the Mitsubishi Web Licensing 
Utility” 

Note:  If you uninstall the Software License Utility, the 
KillCode*.TXT file will be deleted. For this reason, make 
sure you copy the KillCode*.TXT file to a safe location 
or be sure to note or print its content before uninstalling 
the Software License Utility on the PC. [* = Site Key 
that was killed.] 

4.3 License Viewer 

When you purchase licenses, the licenses are measured in a 
point count that determines the number of OPC tags that you 
can use in your application. One point count is used for most 
AX Application applications. There are two different modes 
for using tags in point counts: 

 On-demand mode. A system for dynamically using licensed 
points, and then reusing the points as needed. The count 
at any instance includes only active points in use.  

 Configure mode. A system in which all points are 
statically configured in a static central location, inside 
the Unified Data Manager. All configured points are 
counted against the point count.  
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The two mode types are not interchangeable and require 
you to buy a new license to upgrade your existing license 
status. 

At any time, you can use the License Viewer to review the 
license status of products installed on that computer. You 
can access the License Viewer in either of the following 
ways: 

 From the Windows desktop: click Start > All Programs 
> MELSOFT > MC Works64 > .NET Licensing > 
MonitorWorX Viewer. 

 From the Workbench: from the Tools ribbon click the 
Licensing button. Or from the File menu, select Tools, 
and then Licensing. The License Viewer displays as 
shown in the following image. 

 

The tab that displays initially is the Overview tab, where you 
can see general information about the license for the server 
that the node points to. You can view license information for 
AX Application, MC Works64, Data Connectors, and 
AlarmWorX Multimedia product features by using the tabs 
for those products. To locate the nodes where individual 
product features are consuming the server's license counts, 
use the Diagnostics tab. 
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4.4 Web Licensing 
You can use the Mitsubishi Electric Web Licensing Utility to 
generate a new license, kill a license and transfer a license. 
One function of the Mitsubishi Electric Web Licensing Utility 
is to use it to upgrade your license. 
 
Supported operating systems for using the Mitsubishi 
Electric Web Licensing Utility to upgrade your license include 
Windows 8 x64 (Pro or Enterprise Edition), Windows 7 x64 
(Professional, Ultimate, or Enterprise Edition), Windows 
Server 2008 R2 x64, Windows Vista x64 SP2 (Business, 
Ultimate, or Enterprise Edition), Windows Server 2008 x64. 
Using the utility will require Internet access and a Web 
browser (e.g. Internet Explorer 6.0 and up). 

4.4.1 Acquiring a New Software License 

Users of Mitsubishi Electric software can use the Mitsubishi 
Electric Web Licensing Utility to acquire a new software key 
license.  

4.4.1.1 Issuing a New Software License 

1. On the machine where you want the AX 
Application license to reside, open the License 
Utility by going to Start -> Programs -> 
MELSOFT -> MC Works64 -> .NET Licensing -> 
License Utility. This should open the Software 
License Activation for .NET window. 
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2. You will see a dialog come up with a Site Code 
and “No Current Site Key” within the Site Key text 
box. Leave this window open. 

 

 
 

3. Go to http://www.mcworkslicensing.com/ 
 

4. The main page of the Web Licensing Utility will 
load. Click on the “Software” button to access the 
Software License Options. 
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5. You will be required to log in to access the 
Software License Options. Enter your email 
address and password and click on the “LOGIN” 
button. If you do not yet have an account, you can 
create one by clicking on the “Create New 
Account” link near the bottom of the page. 

 

 
 

6. Once you have logged into the Web site, click on 
the “New License” link in the top navigation bar. 

 
7. Enter your Product Registration Numbers and 

Customer Keys for the products to license, then 
click “Next”. 
Note: Your Product Registration Number and 
Customer Key are usually inside the DVD package 
that Mitsubishi Electric co. sent to you. 
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8. In the next screen, you will be requested to identify 
the end user for whom the license is being issued. 
You can look up a list of users that have been 
previously entered by clicking on the “Existing End 
Users” link or can enter a new one by clicking on 
the “Create New” link. 

 

 
 

9. Clicking the Existing End Users link will open a 
new window with a list of previously entered end 
users (either entered by you or tied to the product 
registration numbers entered in the previous 
screen). Select an end user from the list and click 
“Select” or double-click the selected end user.  
If you, yourself, are the end user and you are not 
listed in the grid, you can click on the “I am the 
End User” link to enter your data as the new end 
user. After identifying the end user, click on “Next”. 
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10. In the next screen, you will see a list of the 
products that are available for you to license. 
Check all the products that you would like to 
license. Copy the Site Code from the license utility 
of the destination machine and paste it into the 
Site Code box of the current Web page, then click 
on “Next”. 

 

 
 

11. Review the license information before proceeding. 
Click on “Generate Key” to issue the new Site Key. 
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12. The next page will show you a summary of what 
will be your license, as well as your Site Code and 
License File. 

 

 
 

13. Download the license file (*.glic) by clicking on the 
link. You will need this file to license the machine. 

 
Note: If you misplace the file after receiving it, you 
can use the View License link with your Product 
Registration Number to download it again. 
 

14. In the Software License Activation Utility, click on 
the “Browse” button and look for the license file 
that you downloaded. 

 
15. Once you have selected the file and the License 

File textbox shows the file path, click on the 
“Activate License” button. 

 
16. You should then receive a popup message 

indicating the status of the license activation. You 
can click on “OK” to close the dialog. 
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17. The Software License Activation Utility should now 
show the current license information, similar to the 
following image. 

 

 
 

18. Notice that the Site Code may change, as 
expected, but the Site Key should be the same 
one you saw on the Web site. 
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4.4.2 Adding to an Existing Software License 

1. Go to http://www.mcworkslicensing.com/ . 

2. Once you have logged into the Web site and 
accessed the Software License main page, click on 
the “Add to License” link in the top navigation bar. 

3. Enter your Existing Site Key, Product Registration 
Numbers and Customer Keys, then click “Next”. 

 

 
4. In the next screen, you will see a summary of the 

current license and a list of products that are 
available for you to add to the existing license. 
Check all the products that you would like to 
license. Copy the Site Code from the License 
Utility of the destination machine and paste it into 
the Site Code text box of the current Web page, 
then click “Next”. 
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5. Review the license information before proceeding. 
Select “Generate Key” as shown in the following 
image. 

 

 
 

6. The next screen will display the new Site Key and 
the link to your license file. Follow steps 13 to 18 
from 4.4.1.1 “Issuing a New Software License” to 
complete the licensing process. 
 

4.4.3 Upgrading a Software License Key 

There are four basic steps when it comes to upgrading a 
license via the Web Licensing Utility: 
 

 Step 1: Kill the older version license and credit it on 
our Web site 

 Step 2: Upgrade the license on our Web site 
 Step 3: Uninstall the older version of software and 
 install the newer version 
 Step 4: License the newer version 

 
The order in which you do Step 2 and Step 3 does not 
matter.  
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4.4.3.1 Killing a License via the Mitsubishi Electric Web 
Licensing Utility 

See Section 4.2.4 “Killing a Software Key License” for the 
initial steps on how to kill a license within the Licensing Utility 
(Software License Activation for .NET) provided on the MC 
Works64 DVD. Be sure to take note of the Site Key and Kill 
Confirmation Code. This information is necessary to put the 
license back on the Mitsubishi Electric Web site.  
Note: This information is also in the KillCode*.TXT file. 
[* = Site Key that was killed.] 
 
Once you have the Kill Code, follow these additional steps: 

1. Go to http://www.mcworkslicensing.com/ 

2. The main page of the Web Licensing Utility will 
load. Click on the “Software” button to access the 
Software License Options. 
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3. You will be required to log in to access the 
Software License Options. Enter your email 
address and password and click on the “LOGIN” 
button. If you do not yet have an account, you can 
create one by clicking on the “Create New 
Account” link near the bottom of the page. 

 

 
 

4. Click on the “Kill License” link in the top navigation 
bar. 
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5. Copy the Site Key from the KillCode*.TXT file into 
the Site Key field on the Web page, then copy the 
Kill Confirmation Code into the Kill Code field on 
the Web page. Next, click on the “Remove Key” 
button on the Web page. 

 
 
6. You will get a message confirming that the Site 

Key has been successfully deleted as shown in 
the image below. The products associated with the 
deleted Site Key will now be available to be re-
licensed. 
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4.4.3.2 Upgrading the License on Mitsubishi's Web Site 

See Section 4.2.4 “Killing a Software Key License” for the 
initial steps on how to kill a license within the Licensing 
Utility (Software License Activation for .NET) provided on 
the MC Works64 DVD. Be sure to take note of the Site 
Key and Kill Confirmation Code. This information is 
necessary to put the license back on the Mitsubishi's Web 
site.  
Note: This information is also in the KillCode*.TXT file. 
[* = Site Key that was killed.] 
 

1. After you have copied your Site Key and Kill 
Confirmation Code in the previous step (either 
physically or electronically), you can now visit 
. http://www.mcworkslicensing.com/ 
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2. Click on the “Software” button to proceed. You will 
then be required to enter your email address and 
password for the site, as shown below. If you do 
not already have a login for this page, click on the 
“Create New Account” link near the bottom of the 
page. 

 

 
 

3. Once you have logged in, click on the “Kill 
License” link in the top navigation bar. 

4. Next, fill in your Site Key and Kill Code information 
that you copied while killing your previous license 
(see 4.2.4 “Killing a Software Key License”). 
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5. Once you kill the license on Mitsubishi's Web site, 
you will receive an email containing the following 
information: 
 Site Key 
 Kill Code 
 Product for which you have killed the license 
 
The Web page itself should now look similar to the 
figure below. 
 

 
 

6. At this point, you have completed killing the 
license. Notice that in the final “Kill License” page, 
as shown above, it states that if the license is 
eligible, it can be upgraded to the latest version 
and it provides a link for availability. 
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4.4.3.3 Checking License Upgrade Availability 

The easiest way to check if your license is available for an 
upgrade is by clicking the link on the page immediately after 
you kill the license. Clicking the link brings you to the 
Upgrade License page. You can also get to this page by 
clicking on the “Upgrade License” link in the tree control 
(third item). 
 
Follow these steps to upgrade your license. 

1. On the Upgrade License page, fill in your Product 
Registration Number and Customer Key. This is 
the same information you received in the Web 
page and in your email after you have killed the 
license on our Web site. 

 
2. Click on “Next” when you have filled in the 

necessary information. 
 
3. If the license is available for an upgrade, you will 

see the available license on the page. 
 

 
 

4. Notice that the Product Description here shows a 
different product with an earlier version license 
(Version 8). Yours should reflect the license you 
have for your product. Check the available product 
that you would like to upgrade and click on “Next”. 

 
5. The next page is a confirmation page. Check that 

the information shown is correct and click on the 
“Upgrade” button to proceed. 
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6. On the new page that loads next, you can see a 
list of upgraded products. Notice that the Product 
Description shows a license for a later version 
product (Version 9.2) instead of the earlier one 
(Version 8). 

 

 
 

7. You should also receive an email with the license 
upgrade information. 

4.4.4 Upgrading a Hardware Key License 

Upgrading a hardware key license is similar to upgrading the 
software key license. You would follow the exact same 
procedure as upgrading a software license. In the case of a 
Hardware key License though, you will need the USB dongle 
in order to kill the license from it and put the new one onto 
the key. 

4.4.5 Licensing the New Version 

Now that you have upgraded the license, you can follow the 
regular procedure to license your machine with the new 
version. When it asks you for the Product Registration 
Number and the Customer Key, you can provide the same 
one. This information was sent to you in the last step of 
upgrading your license via email.  

4.4.6 Software Key Replacement 

Please fill in the online “Key Replacement Form” at  
"http://www.mcworkslicensing.com/" to start the replacement 
process of the original license if your license has been lost. 
Once your license has been recovered, follow the steps in 
the section titled, “4.4.1.1 Issuing a New Software License” 
to activate the new license. 
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4.5 Demo Mode 

Without a valid license installed in your PC, it is still possible 
to use AX Application in Runtime mode. The software will 
check for a valid hardware or software license key on 
initialization. If none is found, MC Works64 runs in Demo 
Mode, which limits you to: 

 Twelve hours of runtime 

 Only 64 OPC tag connections (points) can be updated 

Running AX Application longer than the 12-hour limit 
generates a message stating that the demo time has been 
exceeded. You must then exit AX Application and reboot the 
PC. On restarting AX Application, you will get another 12-
hour block of time in which to run. If there are more than 64 
tags on a particular screen, gray keys (or whatever is 
configured as the Point Failure character) will appear in 
place of the actual I/O data. 
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5 AX Application Quick Start 

5.1 Introduction  

This chapter provides a brief overview of the following AX 
Application products and tools: 

 Workbench 
 AX Energy  
 AX Facility  
 AX Portal 
 Additional tools and utilities 

Note: For complete information about any AX Application 
product, please refer to the Help documentation, which you 
can launch from the product itself. 

5.2 Workbench 
The Mitsubishi Electric Workbench is a multi-functional, 
centralized Web-based configuration environment and is 
included as part of the Platform Services in the AX 
Application suite installation. 
 
Workbench-SL offers a light-weight deployment with a fast 
startup time, which also supports third-party plug-ins. 
Workbench-SL has a look-and-feel that is similar to the 
Classic Workbench, including familiar elements such as a 
tool bar ribbon and Project Explorer, but with enhanced user 
friendly options such as a list-view Project Explorer for 
browsing which can be filtered and sorted. 
 
Workbench-SL runs in all browser platforms, including 
Microsoft Internet Explorer, Firefox, Chrome, Safari, and 
more. It has a runtime mode known as AX Portal-SL, and its 
Silverlight components are available as Web Parts in 
SharePoint (via AX Portal-SP), plus they can run on 
Windows Phone operating systems. 
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In Workbench, you can: 
 Organize data sources on the basis of a 

hierarchical structure of assets and equipment, 
using AssetWorX. 

 Calculate, report on, and manage energy use if 
the AX Energy provider is installed. 

 Locate and react to AX Facility faults if the 
FDDWorX provider is installed. 

 Monitor and control SPC calculations if the AX 
Quality provider is installed. 

 
Many configurations can be done from within the Workbench. 
What can't be done inside the Workbench can be done via 
Classic Workbench or Workbench-SL, installed as part of 
MC Works64 suite. 
 
To open Workbench-SL, from the Windows Start 
button, select All Programs > MELSOFT > MC Works64 > 
Tools > Workbench-SL. 
 
When you open the Workbench for the first time, you will be 
able to see all of the applications, tools, utilities and services 
listed in the Project Explorer that you can open within the 
Workbench. 
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It is made up of: 
 The Ribbon bar (along the top). 
 Two Project Explorers that you can hide or show: 

o A tree explorer that gives you a way to 
navigate and browse; and buttons that give 
you access to Mitsubishi Electric providers. 

o A grid explorer you can use for searching. 
 The content or work area where configuration 

forms open. 
 
Ribbon: 
The ribbon for the Workbench-SL is designed to help you 
quickly find the commands you need to complete a task. 
Commands are organized into logical groups. 

 

 
 
You can minimize the ribbon by double-clicking on the ribbon 
tabs. 
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Development and runtime modes of all installed and licensed 
AX Application and MC Works64 products can be accessed 
and used in the Workbench.  
 

 
 
Even though all of the providers are available in the 
Workbench, you can pick and choose which providers 
appear in the Workbench's Project Explorer. 
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5.3 AX Energy  

AX Energy is an off-the-shelf Energy Management System 
(EMS) that focuses on energy data analysis to increase 
efficiency and reduce overall operational costs. It helps with 
improving energy usage patterns, monitoring energy 
reliability, and even forecasting energy consumption.  

 

Information obtained from AX Energy can be used to: 

 Optimize your energy management program 
 Drill down to identify inefficient assets that 

consume too much energy  
 Identify peak usage periods to load-balance 

assets and take advantage of off-peak rates 
 Visualize energy usage per site, normalized by 

square foot or square meter 
 Analyze carbon footprint per person / per site 
 Monitor equipment energy usage trends and details 
 Notify personnel with alerts when meters fail or 

energy usage is unexpectedly high 
 Automatically email energy consumption and cost 

information to managers 
 Quick to deploy and achieve ROI 
 Realize cost-savings through informed decisions 

 
To launch AX Energy, from the Windows Start menu, select 
All Programs > MELSOFT > MC Works64 > Tools > 
Workbench-SL. Then, select the AX Energy provider within 
the Project Explorer on the left. 



AX Application Quick Start   

 MITSUBISHI ELECTRIC 5-6 

5.3.1 Quick Start with AX Energy 

The following is a checklist of the steps for getting started 
with AX Energy from a configuration and runtime operations 
standpoint. Note that much of AX Energy 's configuration 
happens in the AssetWorX provider, so you will be using a 
combination of both AX Energy and AssetWorX to configure 
your energy information.  
 
Before You Begin 

1. An AssetWorX configuration database, which 
hosts all asset related and also AX Energy related 
information, must be in place and must be 
activated. For more information, refer to the “AX 
Energy Configuration Databases” Help topic (in 
the “AssetWorX” section). 
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Note: To access the Help for AX Application, click 
on the Help menu option within the application 
itself OR, from the Windows Start menu, select All 
Programs > MELSOFT > MC Works64 > Help > 
Help. See Chapter 6 of this guide, “Help and 
Technical Support”, for more info. 
 

2. Energy AX Application must be installed to your 
AssetWorX configuration database. It can be 
installed via the AssetWorX provider's Available 
Solutions node. For more information, refer to the 
“Installing Available Solutions” Help topic for 
AssetWorX. 

 
3. Plan the asset tree with your energy-related needs 

for AX Energy in mind. Refer to the “Strategies for 
Building the Asset Tree” Help topic (in the 
“AssetWorX” section). 

 
Checklist for Implementing AX Energy 
 
To configure AX Energy properly, you will need to follow 
these steps: 
 

1. Configure the following properties in AssetWorX: 
a. Units. For step-by-step instructions, 

refer to the “Defining Units of Measure” 
Help topic (in the “AssetWorX” section).  

b. Temperature sources (optional). For 
step-by-step instructions, refer to the 
“Defining Temperature Sources” for 
AssetWorX.  
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2. Configure the following AX Energy general 

options: 
a. Configure general options, including 

options for logging meter data, in the 
General Options' Settings tab. For 
information, refer to the “Setting Options 
for Processing and Data Collection” 
Help topic. 

b. Use the General Options' AX Application 
Properties tab to define AX Application 
Properties for numeric or descriptive 
data you want to use in energy-related 
calculations, for generating or sorting 
AX Energy reports, or for otherwise 
categorizing your energy-related data. 
Refer to the “Meta Data (Bindings)” Help 
topic.  

c. Use the General Options' Table 
Maintenance tab to “Set Conditions for 
Removing Old Energy Data from 
Tables” (see Help topic of same name).  

d. Use the General Options' External Data 
Processing tab to manage the process 
of importing data from external sources. 
For more information, refer to the 
“External Data Entry” Help topic. 

e. Use the General Options' MC Historian 
tab to integrate data from MC Historian 
for use in meters or bindings. For more 
information, refer to the “Integrating with 
MC Historian” Help topic. 

f. Configure meter types using the 
Consumption node. For more 
information, refer to the “Adding Meter 
Types” Help topic.  
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3. Configure information for doing energy-related 
calculations: 

a. Configure cost centers for monitoring 
energy costs for business units. Refer to 
the “Defining Cost Centers” Help topic. 

b. Configure utilities' rate models for use in 
cost allocation and various energy cost-
based reports. Refer to the “Defining 
Rate Models for Utility Sources” Help 
topic.  

c. Configure your energy-related 
calculations and calculation categories. 
Refer to the “Defining a Library of 
Calculation Templates” Help topic. 

 
4. In AssetWorX, define to the asset tree all of your 

AX Energy assets. To understand this process, 
refer to the “Configuring the Asset Tree for AX 
Energy” Help topic. The asset tree must include: 
your energy assets, meters for your energy assets, 
and your utility sources.  
 
To configure your AX Energy assets in the asset 
tree: 

a. Define the utilities that supply energy to 
your corporate and business resources. 
Refer to the “What Is a Utility Source 
and How Is It Used?” Help topic for 
information. To configure your utility 
sources, follow these steps (that 
correspond with their Help topic titles): 

i. “Configure Your Utility 
Sources” 

ii. “Specify the Utility Source's 
Cost Center” 

iii. “Configure the Utility Source's 
Meter Type and Rate Model” 

iv. “Define the Utility Source's 
Bindings”  

v. “Activate the Utility Source for 
Energy Analysis”  
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b. Define your meters that measure your 
energy consumption (these can be real 
or virtual meters); and meters that 
measure inputs, outputs, and loss for 
systems such as water flow or air flow. 
Refer to the “What Is a Meter and How 
Is It Used?” Help topic for important 
information.  
 
To configure your meters, follow these 
steps (that correspond with their Help 
topic title): 

i. “Configure Your Meters”  
ii. “Specify a Meter's Cost 

Center”  
iii. “Define a Meter's Bindings”  
iv. “Activate a Meter for Energy 

Analysis”  
c. Identify the energy assets in the asset 

tree. An energy asset is any equipment 
for which you want to collect and 
aggregate energy data. Refer to the 
“What Is an Energy Asset?” topic for 
critical information. To configure your 
energy assets, you will follow these 
steps: 

i. “Identify Your Energy Assets”  
ii. “Define an Energy Asset's 

Bindings”  
iii. “Specify an Energy Asset's 

Cost Center and Energy 
Budget” (optional) 

iv. “Configuring Calculations for 
an Energy Asset”  

v. “Activate Energy Analysis for 
an Energy Asset”  
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5. At this point you should be ready to start up your 
AX Energy service to begin collecting and 
analyzing data for your configured meters and 
energy assets. Once the service is started you can 
of course continue to add to your configuration 
and make runtime changes as your application 
needs evolve. Before starting up the service you 
should do the following: 

 
a. Verify that your service settings for 

processing and data collection are 
appropriate for your application. For 
more information, refer to the “Setting 
Options for Processing and Data 
Collection” Help topic. 

b. Review some tips and tricks related to 
optional optimizations that can be 
enabled or disabled via server-side 
configuration files. For more information, 
refer to the “Optimization” Help topic. 

c. Start up the AX Energy service either by 
clicking on the traffic light in the 
Workbench, or by launching “Services” 
from the Windows Control Panel, 
Administrative Tools, and starting the 
AX Energy service. 

 
6. Upon service startup, AX Energy will verify that 

you have an appropriate license for the number of 
enabled Meters. For more information, refer to the 
“Validating an AX Energy License” Help topic. 
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7. Now that the AX Energy service is running and 
collecting data, you can then focus on creating 
runtime views and dashboards for role-based 
visualization and analysis. This involves: 

 
a. Configuring charts, grids and drill-down 

analysis within the AX Energy Viewer, 
as outlined in the “Configuring the AX 
Energy Viewer - Quick Start” Help topic 

b. Configuring right-click menu items, as 
described in the ” Setting up Commands 
for Runtime Navigation” Help topic, so 
that runtime users can run or access the 
reports they need to be able to use. 

c. Making those available for viewing 
within one or more of the powerful 
visualization platforms.  
 
You can utilize your AX Energy Viewer 
configurations and right-click commands 
within the following environments: 

i. GraphWorX64 (WPF or 
Silverlight displays) 

ii. AX Portal-SL (thin client 
dashboard) 

iii. AX Portal-SP (SharePoint-
based portal) 

 
For further information, see the “Overview of AX Energy” and 
“How AX Energy Works” Help topics. 
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5.4 AX Facility 
AX Facility is a predictive building automation solution that 
leverages Fault Detection and Diagnostics (FDD) technology 
at its core to detect and predict faults in equipment. It 
incorporates algorithms that weigh the probability of faults 
and advises management, operators and maintenance 
personnel of actions to prevent equipment failures or 
excessive use of energy. With Web-based configuration, AX 
Facility is easy to setup and deploy, integrating with most 
popular BAS, SCADA and building systems. An extensive 
library of standard equipment diagnostic models speed setup 
and configuration, while a rules based editor lets you easily 
customize and add new equipment diagnostics models. 
 

 
 
When equipment failures occur, advanced software 
technology provides automatic guidance to a list of causes 
sorted by probability, resulting in reduced downtime and 
lower costs to diagnose and repair.  
 
Information obtained from AX Facility can be used to: 

 Predict, reduce and eliminate equipment downtime 
 Automate fault detection and real-time notifications 
 Reduce maintenance and determine probable 

causes 
 Improve reliability and control 
 Improve overall environmental quality 

 
To launch AX Facility, from the Windows Start menu, select 
All Programs > MELSOFT > MC Works64 > Tools > 
Workbench-SL. Then, select the AX Facility provider within 
the Project Explorer on the left. 
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5.5 AX Quality 
AX Quality is part of the AX Application product suite from 
Mitsubishi Electric. With AX Quality, you can monitor the 
efficiency and reliability of any system using statistical 
methods. These tools allow you to detect and correct for 
anomalies in your industrial process more easily than ever 
before. 
 

 
 
This component of the AX Application suite allows you to 
access and configure SPC tags, distribution rules, and 
statistical calculations in MC Historian. You can also create 
and view trends and alarms associated with SPC tags and 
calculated tags within TrendWorX64 or AlarmWorX64.  
 
AX Quality also supports: 

 New chart types in TrendWorX64 (Histogram and SPC)  
 Integration with ReportWorX Express and 

ReportWorX 365 
 Dashboard customization in AX Portal-SL  

AX Quality delivers charts, KPIs, data, and alerts to any 
device, any time. It also provides an extensive set of viewing 
options to create dazzling displays and dashboards for your 
device. These views allow you to monitor your processes, 
identify issues, and fix them in a proactive manner to 
achieve better performance for your system. 
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5.6 AX Portal 
AX Portal is real-time collaboration and visualization 
dashboard technology that allows users to easily create and 
manage custom manufacturing portals, business portals and 
visualization dashboards that provide single sign-on 
collaboration for optimization of key performance indicators 
(KPI). AX Portal offers users the power of choice when it 
comes to deployment options, via the AX Portal-SL and AX 
Portal-SP products. 
 
AX Portal-SL requires virtually no administration, is easy to 
configure and delivers data anytime and anywhere through a 
standard Internet connection. It is included as part of 
Platform Services, and can be deployed to any browser 
using Silverlight technology. 
 
AX Portal-SP enables deployment of any visualization 
controls within a SharePoint environment. Standard Web 
parts from Microsoft's SharePoint Server and customized 
Web parts for nearly every facet of manufacturing 
intelligence ensure you have everything you need to create a 
portal for your real-time historical plant and business 
information. 
 

 
 

AX Portal-SP offers native support for SharePoint 2010 as 
well as manufacturing intelligence Web Parts for AX 
Application and MC Works64 solutions.  
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These Web Parts allow you to “SharePoint-enable” your 
existing application to easily expose information to a variety 
of user roles, including operations management, quality 
management and executive level users. extensive library of 
Web parts includes: 
 

 AssetWorX Navigator – for browsing your ISA-95 
standard hierarchy 

 AlarmWorX64 Viewer – for viewing and managing 
alarms 

 AX Energy Viewer – allows you to visualize data 
from the AX Energy solution by exposing 
information from the cost, consumption and 
carbon calculations 

 AX Facility Viewer – to visualize faults and 
diagnose probable causes from powerful FDD 
technology 

 GraphWorX64 Viewer – for interactive HMI/ 
SCADA displays 

 GridWorX Viewer – for viewing and interacting 
with data in a grid format 

 Report Executor – for executing reports with 
powerful user-defined parameters 

 Report Viewer– for visualizing reports in Excel, 
PDF, or HTML format 

 Schedule Control - for viewing set schedules 
within the AX Portal-SL Runtime environment 

 Smart Tile Viewer - for viewing useful, at-a-glance 
graphic visualization tools 

 TrendWorX64 Viewer – for real-time and historical 
trends and charts 

 Image Viewer - to add a preferred graphic to the 
AX Portal-SL Runtime environment 

 
Note: For additional information, be sure to read the 
Mitsubishi Electric Application Note, “AX Portal-SP - 
SharePoint 2010 Integration”, located on the AX Application 
installation disc. 
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5.7 Additional Tools and Utilities 

There are additional tools and utilities that are installed with 
AX Application. A brief description of each is described below. 
For more information about a tool or feature, refer to the Help 
documentation included with the product. 

5.7.1 License Utility  

License Utility (Start > All Programs > MELSOFT > MC 
Works64 > .NET Licensing > License Utility) provides full 
authorization for use of any purchased AX Application 
product and its available options. See page 4-2 for more 
information. 
 

 

 



AX Application Quick Start   

 MITSUBISHI ELECTRIC 5-18 

5.7.2 MonitorWorX Viewer  

MonitorWorX Viewer (Start > All Programs > MELSOFT > 
MC Works64 > .NET Licensing > MonitorWorX Viewer) 
allows users to review the status of Mitsubishi Electric 
licenses. See page 4-1 for additional information. 
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5.7.3 Configure AX Application  

Configure AX Application (Start > All Programs > 
MELSOFT > MC Works64 > Tools > Configure System) 
allows you to configure the product similar to the options you 
were provided during installation. See Step 8 onward of 
“Starting the Install / To Install AX Application” on page 3-2 
for detailed steps. 
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5.7.4 SQL Server Setup  

SQL Server Setup (Start > All Programs > MELSOFT > MC 
Works64 > Tools > SQL Server Setup) allows you to select 
the SQL Server(s) that will be used by the applications. The 
added SQL Servers will then appear in Workbench to assist 
in the creation of, or connection to, databases. 

 



 AX Application Quick Start 

MITSUBISHI ELECTRIC 5-21 

5.7.5 TraceWorX  

TraceWorX (Start > All Programs > MELSOFT > MC 
Works64 > Tools > TraceWorX) provides online diagnostics 
and tuning of applications. TraceWorX is intended for use by 
systems integrators, OEMs and customers who want to have 
tools for doing their own troubleshooting and diagnostics.  
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6 Help and Technical Support 

6.1 Online Help 

AX Application provides online help with descriptions and 
explanations of each application. Help is available 
throughout MC Works64. You can access help in the 
following ways: 

 Click the Help  icon in the Workbench. This opens 
the help file for that application. To search for a topic in 
the help file, click the Index tab or the Search tab. Type 
or select the term you want to find, and then click the 
topic you want to read. 

 Press the F1 key to display context-sensitive help. 

 Click the Help button in any dialog box to display 
context-sensitive help for that dialog box. 

 Move the mouse pointer over an icon and pause for a 
moment to display pop-up ToolTips for quick help. 
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7 Notes 
 Depending on the application settings, operation of the 

application may be unstable because the memory 
allocated by the operating system has been consumed 
up to the upper limit. Please configure the setting 
properly to prevent it. 
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